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b Why is it called — Emacs?
ema CS The name ‘Emacs’ was originally chosen as an abbreviation of
Editor MACroS and was created by Free Software Foundation.

This document includes highlights of some new and existing features and fine points in this customised

version of Emacs.

This customised version based on the GNU Emacs 25.3.1 (x86_64-w64-mingw32) of
2017-09-17 and Smallworld additions to the Emacs release with GE Smallworld 4.3.

All comments and suggestions please forward to <igor@hydepark-consulting.com> . You can download this Emacs from
HydePark-Consulting.com/Emacs and view explanations of added features and Emacs useful tips on MagikEmacs.com
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http://www.hydepark-consulting.com/emacs.html
http://www.magikemacs.com/

New in this customised version of Emacs 25.3.1

- Creating complete directory structure with few
default files (product.def, module.def and
load_list.txt) for a PRODUCT or MODULE using
Emacs menu options. See examples for
TEST_PRODUCT & test_module directories:

6 GNU Emacs 25.3.1 [] -= Wed Oct 4 15:47 0.50 =-

File Edit Options Buffers Tools S¥
Alias Files
Create PRODUCT Dir.Structure
Create MODULE Dir.Structure

Help
GEZs £4

Select Smallworld Environment f2s
Run/Goto Smallworld Session f2z
Start New Smallworld Session C-uf2z
Gis Processes >
Class Browser >

v

Class Browser Processes

Shell Processes >

List Processes stroke commands

nent of the GNU operating system.

C=q

L TEST_PRODUCT
build.xml
product.def

<- PRODUCT directory structure with files

config
product.def

—magik images
load list.txt
module.def

<- MODULE directory structure with files

resources
base
bitmaps
data
n_gb
L —_messages
source
load list.txt

data
images
L main
1libs
modules
L——testimodule <- MODULE directory structure with files
load list.txt
module.def
resources
base
bitmaps
data
n_gb
L — messages
source
load list.txt

resources
base

bitmaps
data
icons
Java
oc
[Ezzgxamples
lib

en gb
I:he ip
messages
scripts

source
load_list.txt

- Visual Bookmarks provides easily File Edit

visible bookmarks, which can be

Options

Buffers Tools SW Index Magik YASnippet Help

DEE*E9 Y 8B Ry a0 &

set/cleared via CTRL-F5 and Toolbar

icon OR simply by clicking on a LEFT
fringe. Navigation between /

= <l [ substation.magik
c2 << ¢ e.new (10000,0)
<< coordinate.new (10000,10000)

Set Bookmark

c4 << coordinate.new(0,10000)
box << sector.new with(cl,c2,c3,c4,cl)

si.make geometry (:boundary,box)

bookmarks F5-n/F5-p or using the R
Toolbar icon. List bookmarks - use l
Alt-x ‘om-show’ (current buffer) and

Alt-x ‘om-show-all’ (all open buffers). endmethod

_protection

ok? << true }
Navigate Bookmarks

vﬂew. end_lwt (ok?, true )

_endprotect
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- Save Frames Layout — allows to save the current Emacs Frames layout (number of Frames and positions on

a screen) and restore saved Frames configuration on Emacs startup.

eGNU Emacs 25.3.1[] -= Fri Oct 6 13:04 0.77 =-
File Edit Options Buffers Tools SW Help

Alias Files > TEHAS £4

Create PRODUCT Dir.Structure

Create MODULE Dir.Structure

Select Smallworld Environment f2s

Run/Goto Smallworld Session faz

Start New Smallworld Session C-uf2z

Gis Processes >

Class Browser >

Class Browser Processes > lnent of¥he GNU operating system.

Shell Processes >

List Processes stroke chmmands

Tools > Emacs q@de Browser <f12> b

Customise > Save Frames Layout b

Help > Breadcrumbs list <f5> <return>
Topying Conditions — COoNAfionS Tor 1 command Shell Moz
Ordering Manuals Purchasing prir  jmenu S ouse

Occur M-s o
Tostart... OpenacFile OpenHon 4

To quit a partially entered command, 1

Speedbar
MiniMap Mode

Tl H AN AC N A [.ON A

EXAMPLE: | always use 2(Two) Emacs Frames — 1st Frame split horizontally (Ctrl-x-2) with *gis* buffer
(locked/dedicated mode) and Class Browser, 2nd Frame using for coding. So, | use this feature to save the
Frames Layout and restore on the startup. Use <Alt-f> to switch between frames.

@ GNU Emacs 25.3.1] -= Fri Oct 6 13:26 =- @ GNU Emacs 25.3.1[] -= Fri Oct 6 13:26 =- - o X

File Edit Options Buffers Tools SW Help ] File Edit Options Buffers Tools SW Index Magik YASnippet Help
DeEx@8 % *aBRIYPARNCEETEFEGNpExEI9 YaB Ry Y FEETEHE 2a
- <+ *GNU Emacs* -

ﬁ# This buffer is for Magik code evaluation and for \ A
S S 51 b St 60 g SE RS0

y ## Use [Magik] Menu OR standard Key Bindings to Tra \
snsmit Method/Region/Buffer.

1st: firame)

Welcome to GNU Emacs, one component of t z,m@ Fﬁalm@)

Emacs Tutorial Learn basic keystroke ¢
Emacs Guided Tour Overview of Emacs fea
View Emacs Manual View the Emacs manu

v
| 1\-—-- *scratch* AN eENIS 6 ([170) (Magik H
«For information about GNU Emacs and the GNU system, \ A

IV
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NOTE: another NEW feature - now the *scratch* buffer can be used for Magik code evaluation (see above)

- The Java Development Environment for Emacs (JDEE) is an add on software package for Emacs that assists

in Java programming. JDEE provides ability editing,
compiling, running, debugging, and browsing large Java

File Edit Options Buffers Tools S

@ GNU Emacs 25.3.1 [ d:/Emacs-24.1.1/emacs-23/site-lisp/features/cedet-1.0/semant

M Classes JDEE Java Development Jdb [YASnippet

O0®=8x  Compile CcCvCc HEE . .
programs. REESERE  RunApp C-cCyc.r [serjavijfestiavacomp.java
lass Run Unit Test C-cC-vC-u :
@ GNU Emacs 25.3.1 [ d:/Emacs-24.1.1/emacs-23/site-lisp/features/cedet-1.0/semantic/tests/t Debug App C-cC-vCd (
File Edit Options Buffers Tools SW Classes JDEE Java Development Jdb YASnippet Help } Run Applet C-cCvC-a
Visit New File... cxcf EHswxa . Debug Applet
Open Recent , prjavatestjavacomp.java Build C-cC-vC-b
Open File... L ) Find >
JDEE New > Class... Interpreter >
Open Directory... C-xd Interface... ﬁ Documentation > }
Insert File... C-xi Console... Code Generation > }
Close Bean... Browse > { }
Save C-x C-s Unit Test... Check Style
Save As... C-x C-w EJB > € Project >
Revert Buffer Build file... > Refactor > ne()() ; { {
e
Recover Crashed Session Other... ) Help >
== === [T

Before you can use the JDEE you must tell it where the Java compiler, debugger, and virtual machine are

located on your system.

Refer

to <

".\emacs253 64\share\emacs\25.3\site-lisp\features\jdee-

2.4.2\Emacs JDE User's Guide.html"> on how to select and register JDK. Or simply edit these values in the

".\emacs253_64\.emacs-custom":

'(jdee-jdk (quote ("9.0")))

'(jdee-jdk-registry (quote (("9.0" . "C:\\Java\\jdk-9"))))

@GNU Emacs 25.3.1 [ c:/emacs253_64/fras_engine.magik] -= Fri Oct 6 14:04 0.64 =-

-  MINIMAP mode -
display of the current buffer
on the left side. It highlights
the currently shown region

smaller

and updates its position

automatically. You can
navigate in the minibar by
dragging the active region
with the mouse, which will

scroll the corresponding edit

File Edit Options Buffers Tools SW Index Magik
Alias Files >
Create PRODUCT Dir.Structure
Create MODULE Dir.Structure

Select Smallworld Environment f2s

Run/Goto Smallworld Session f2z
Start New Smallworld Session C-ufez
Gis Processes >
Class Browser >
Class Browser Processes >
Shell Processes >
List Processes

Tools >
Customise >
Help >

YASnippet Help
ETEHsg LA

iV (RPC) SW410 (Upgrad \

tthod.Retain this metho \

new ()
.size

Emacs Code Browser
Save Frames Layout
Breadcrumbs list

<f12> b

<f5> <return>

X | Command Shell M-2  fomn
buffer. _self.(j.llag( S Imenu <S-mouse-2>
5, t0 << date time.now() ) ) ST e
All
for i route over i}
) - - - Speedbar
_____BECY ¥ it Mode
For f ==isil IToggle display of MiniMap for the current buffer ‘l
‘) .elements () - - v Global YASnippet mode
:  Glahal Fant L acle
HY DI
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http://en.wikipedia.org/wiki/Emacs

Two simply useful new features:

- Use Ctrl-Shft-d to duplicate current line of code

- Use Ctr-Alt-Up/Down arrow to move current line or selected block of text Up and Down

Watch MagikEmacs.com for more explanations on custom features of Emacs IDE for GE Smallworld.

- Intelligent AutoComplete ( ), which understands classes,
methods(functions) and even <_self> - offering only methods defined on “self” class :

_pragma (classify level=restricted)
7method"substatioﬂJget_spatial_context_names()|

T

#4# Returns extra spat¥agl context names to add te the
## application defined

##

atial contexts.

>> { :internals }

_endmethod
$
_pragma (classify level )
_method substatio .dIaw_internals(window, my_geometLy, Iwo_style, draw_flag?)
##
## A draw method whch renders the substation's Mternal world
## within the bounds of its geographic location ge
##

_dynamic leurrent rendering context!

get_spatial context names|(}J]
geom qet_spatial_context

ace  get_spatial context() f |get_spatial context names ()
an_s get spatial context names RESTRICTED!
get spatial context names() Returns extra spatial context names to add to the

_if get spatial context element for world() £ | application defined spatial contexts.
( gsf << rc.geometry set_factory ) _isnt unset
_then
display scale name << :auto
an_sts << gsf.get_style system for( ace_name, display scale_name )
endif
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http://www.magikemacs.com/

- Custom Toolbar and Tab-bar (use <Ctrl-Tab> to navigate between tabs).

File Edit Options Buffers YASnippet Tools SW Custom 5SW  Magik Help

DEEEBE « ¥BBEREXBHF&E Y VP ESHAEE x @ VG

= <] [ methods_and_classes.magik '?_j

#% text encoding = isc8859 ]
_package sw / mouse-1: switch to buffer "draw_arrow magik"
# Tab-bar mouse-2- pop to buffer, mouse-3- delete other windows Custom Toolk

#MagikSF> object.define method target.metadata|:behaviour sinks].p

- Save/Restore editing Sessions, which allows you with one click of a button to load multiple files from a
previous closed editing session. Even a cursor positions in the open files will be preserved from the
previous session.

LT

Open Saved Session |

- Dynamic Abbreviation - it is a standard function in the Emacs, but, from my experience, not everybody
knows about. It is allowing you to write just a few characters of words you've written earlier to be able to
expand them. Possible completions searched in the text in the current buffer, and if not found there, in all
open buffers. To expand a word, just put the point right after the word and press <Alt-/>. As soon as you
start typing — you are able to use this feature. Typing the next letter will automatically narrow your

possible completions.

# Push it out to the owning fram # Push it out to the owning fra
# respond to. # respond to.
_self.framework.databus.make dat _self.framework.databus.make_da
~self.app _self.applicationl

_endmethod \ _endmethod

s 3 completed

- Dynamic Abbreviation with Expansion of Multiple choices — press the same key second time and you will
get multi-choice candidates in a tooltip.

Push it ocut to the owning frame

#
# respond to.

_self.framework.databus.make data_

_se1£.3p0 3y app_dev_examples
(s). appear
§endmethod (d): applies

|

[
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- Predictive Abbreviation. It’s fairly similar to Dynamic Abbreviation expansion, which works based on the
contents of the current buffer (or other buffers). Predictive abbreviation expansion works based on the
previously written text. Unlike Dynamic Abbreviation, the text is analysed during idle time, while Emacs is
doing nothing else. As you type you will be offered possible expansion for the word at the left from the
cursor position. Typing new characters will automatically offer different completion. If the correct
completion is offered — just press <Tab> to complete the word. Light blue colour indicates that there are

possible different candidates for the expansion. To

see other candidates — press <Tab> once again and

choice of possible completions will be shown. If the completion is shown in the dark blue colour — that’s

mean this is the only possible candidate.

- Automatic insertion of the corresponding ({[ and “. Thus typing *(

rmine which data

# te
# should do with the da
iE

termine which data
# should do with the da
self.datan |

termine which data t

te
hould deo with the dat

_self.data_ | SisEmeent |

A e

Determine which data types we

should do with the data that is

_self.databusdatabus 1
data_type name 2
database 3

will normally insert ()

1

and put the

cursor between them. Otherwise, when the region is active, it will be wrapped in the parentheses.

=1
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@ GNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mo

File Edit Options Buffers Tools SW Index Magik YASnippet Help
EfEHa x4

Alias Files >
Create PRODUCT Dir.Structure

Create MODULE Dir.Structure
- Use SW->Tools menu to

>elect smallworld lEnyitopment f2s ], topic={application_development exeample
activate/deactivate many Riln/coto smalwor el =ien = { :record selection, :map_trail
. Start New Smallworld Session C-uf2z :public )
USEfU'OpUOﬂS. Gis Processes >
Class Browser >
Class Browser Processes > )
Shell Processes >
List Processes !, topic={application development exeample
Tools h > Emacs Code Browser <f12> b | PLug
Customise > Save Frames Layout
Help > Breadcrumbs list <f5> <return>
P ESSITEUONACETOINISWREISEE  command Shell M-z
£ Imenu <S-mouse-2>
2 Occur M-s o
1 All
‘e Speedbar
oy MiniMap Mode
endmethod Dynamic TODO Mode
S v Global YASnippet mode
v Global Font Lock
_pragma (classify level=[EISStE v Global Highlight Current Line mode ample
## Reacts upon information|¥| Skeleton Pair mode
## databus. v Auto-Complete Mode
_method highlight similar p{ ¥ More Structured Buffers | type
_if data type name _is [V Minibuffer Incremental Complete mode
_if data _isnt _uns Show Trailing Whitespace
.current trail < Highlight Changes Mode: Active
_else Highlight Changes Mode: Passive
-current trail < |jghlight Changes Mode: Off
._endif : HCM: Rotate Faces
el ] data_typcla_name —1%  HCM: Goto Previous Change <f12> p
_if data _isnt _unse HCM: Goto Next Change <f12>n

.current rwo set <

(S 1 557 i g |

- Highlight text matching PATTERN.
code highlight a variable to quickly see all places it is

Examples: In a source

modified or referenced. New occurrences of that variable
will be highlighted as they are typed. In a *gis* or another
buffer that is showing lots of output, highlight the parts
of the output you're interested in. Those patterns will be
highlighted as soon as they appear in the buffer. Useful if
you have a lot of output during debugging. This option is
located on the Edit menu.

eGNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source!
File Edit Options Buffers Tools SW Index Magik YASnippet Help

Uiele Cxy @B X HEETEHAEG A
Cut C-w
Copy M-w
Paste ) cv 1=EISME, topic={applicatio:
Paste from Kill Menu : .
this plugin puts on the dd
Clear q :
gin.define shared constant
Select All C-xh - =
{ :geometi
Search > :public )
Replace >
GoTo >
Bookmarks > l=m, topic={applicatior
Fill ctions as provided by the |
Text Properties >pilar plugin./init actions ()

Regexp Highlighting > Highlight Regexp... C-xwh
elf. add_a&ion Highlight Phrase... Cxwp
Highlight Lines... Cxwl
Highlight Symbol at Point C-Xxw.
Remove Highlighting... Cxwr [DY
Patterns to Buffer Cxwb LEtH
Patterns from Buffer C-xwi
sdctlion message, :seled
HYDE
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- Additional menu item for visiting files that were operated on recently

& GNU Emacs 23.1.1 [ e/DEV_LIG/methods_and_classes.magik] -= Sat Jan 30 22:17 -=
Edit Options Buffers YASnippet Tools SW Custom SW  Magik Help

Visit New File... CxCf ) 42 R OE A s - @ z g %
Open Recent 3 e:/DEV_LIG/Magik/draw_arrow.magik —
Open File... e/DEV_LIG/methods_and_classes.magik
Open Directory... C-xd Cleanun list .
' - P |Open e:/DEV_LIG/methods_and_classes.magik |
Insert File... C-xi .
Edit list... -
Clase ) ks].p
Save list now
Save C-xC-s Options...
Canra e [ty g | g

- Snippets for Magik. It allows you to type an abbreviation and automatically expand it into function
templates (similar to electric-magik). Navigation between snippet fields — using <Tab>. Templates will
expand automatically as you type them and they are available via menu too.

then sql-mode 3 B B An ZR & i = 3
o e die N XP IO P EEEHE - &
— ruby-mode
—Else rst-mode >
>> false " g ace out ( a_node, _gather args )
; - - 3
_endif pythen-mode
_for lvalue, tuple> _over <iter invocation> cperl-mede v passing ARGS to the network follower.
loop perl-made >
o B maml-mode » fe out for description of ARGS
_endloop markdown-mode v o
magik-mode » definitions N
latex-mode 4 control structure 3 block ... endblock block =>
html-mode 3 parent mode 3 catch ... endcatch catch =>
f30-mode 3 catch ... throw... endeatch catch =>
3 - css-mode 3 continue... continue =>
= <] [» example_framework magik “*TEMP**.magik R R
= objc-mode » continue... with... continue =>
method example framework.jexample test method ()
| o n - - - c-mode 3 elif ... elif =>
o crs-mode v finally.. N finally =>
o . text-mode v | looal, local finally... with... finally =>
_for i_el over self.fast elements() ezl leenil) ] ‘ " for o
;OO‘Q e snippets... now Of.. OVEN. 00D, Endicop or =
if i el is unset Reload all smippets handling... with... handling =>
then About if .. end if=>
- if . else .. end ife=>
leavel
25k
g . g i ... elif ... else ... end ife=>
_end] leave ... if 1 testing o € E5E e EN e
_end'_oo? then leave ... leave =>
leave ... with ... _if leave ... with ... leave =>
_endmethod _then lack... endlock lock =>
g i loop ... endloop loop =>
endif
L cEE - over... loop... endloop oVEr =>
1 # @test package... package =>
proc... endprec proc=>
t protect... protection... endprotect protect =>
BE protect lacking... protection... endprotect pratect =>
ST
throw... with... throw =>
try... when... endtry try =>
c port.magik 1% of 36k (24,21) (Magik AC Pabbrev HL YAS Abbrev) ——[trace_out{)]=

&%

that buffer. Dedicated buffers will have "D" shown in the mode line and marked lock icon. | found it very

- Dedicated mode when a buffer is "dedicated" or locked, Emacs will not select files into

useful to lock the *gis* buffer. NOTE: All minor modes are shown in the mode line and you can use the
mouse to switch it OFF or get Help on the specific mode.

(Magik[D| Ac [Pabbrev] YAS HL [Abbrev)——[trace out()]- D

Turn Off minor mode

Help for miner mode

g T &V YAS HL Abbrev)--—

YT
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- Class Browser — F3-j / F3-b — allows you to go back in the File Navigation history, so you are able to return
to the point in a code where you came from during your F3-j key journey.

- F4-m / F12-m — copy current magik method to the Work (**Temp**.magik) buffer. Very helpful while
making temporary changes in the code or just testing/debugging.

- F2-b —to compile message files <*.msg> directly from Emacs.

- ECB - Emacs Code Browser which displays a number of informational windows that allow for easy source

code navigation and overview.

5NU Emacs 23.1.1 [ e/DEV. | lagik/S ‘example_module/source/example_framework.magik] -= Sat Jan 30 22:39 =
GNU Es 23.1.1 [ e/DEV_LIG/Magik/SWAF/; ipk dule/s /s ple_fra rcmagik] -= Sat Jan 30 22:39

File Edit Options Buffers VASnippet Tools SWCustom SW Magik ECB Help

DR s N\aBREXHOFE U 2 8: x Ae@ 4 g

e:/DEV_LIG/Magik/SWAF/example mod + =4 b|methods and classes magik draw_arrow | maglk\exa e_plugin. magik example_framework. mgglﬂ

@4 example framework.magik .current trayl << _unset -
@] example framework.magikc _endif
¢@+] example_ plugin.magik _elif data type name _is :recokd selection _then
@] example_ plugin.magikc _if data isnt _unset apdif data[2] isnt _unset then
(65] load list.txt .current_rwo_set X< data[2]
H 3 _else
.current_rwo set <<\rwo_set.new()
_endif
_endif ECB related buttons.

E — # This is handy as we let the databus control cur actiecns.
wa() # Think of it as the old note change() methodology.-
el " _self.manage_actions ()
B draw_arrow.magik i -
& example framework.magikl = Listof ci I
B example plugin.magik $ stotcugantl loagded fils,
B gui.xml

A}

_pragma (classify level=basic)

_method example framework.jmanage actions ()
##

## Enable or disable actions as needed.

_Bmethods_and_classes.magik L —=i

L4 ##

W-1 History # Expose this action conly if we have rwos and a closed trail. L

_self_action(:select_in trail) .enabled? << r
Exemplars |+ _if .current trail _isnt _unset _andif
Shared Constants .current_trail.closed?
S s e -
® P 1c Methods - i L4

>> true List of
@ *All Methods* A-7 - = il
_else constantsietc.. in the current buffer

init_actions ()
sw databus data available( data .
= = endif
manage actions () — =
select by trail()
— - endmethod
_® *Class.Methods* =

>> _false

|

o ra e A e _:_\ e
W-2 example framework.magik ——\-— example framework.magik 56% of 3.1k (83,0) (Magik AC Pabbrev HL Abbrev)—-—[manage_actions()]-————8at]

- Integration with an External Editor. This will allow you to load the file from the Emacs, if necessary, into an
external editor of your choice to do some additional editing/searching or other file manipulations.
Use "C:\emacs253_64\NP++Magik_Language.XML" to import Magik highlighting into Notepad++

:s\modules\highlight_similar\source\highlight_similar_demo.magik - Notepad++
ng Language Settings Tools Macro Run Plugins Window ?
P¥ar @ AAMHREICIE33I DEEA

1
== ﬁ ‘ 1™} highlight_similar_demo.magik

= 5
Edit with Ext Editor ;pragma(classwlfy&e'v:?l debug ;toplc' (applliatvloxz;chie\:'e‘lr?pment‘:» fxeamples) usa«

1form n being available on 1e framew

method hlghllght similar_plugin.sw_databus_data_available( data_type_name, ¢
if data_type_name _is :map_ trail then
__if data _isnt _unset _then
.current_trail << data[2]
_else
.current_trail << _unset
_endif
_elif data_type_name _is :record_selection _then
_if data _isnt _unset _andif data[2] _isnt _unset _then
.current_rwo_set << datal[2]
62 _else
63 .current_rwo_set << rwo_set.new()
- 64 _endif

ITI‘
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Magik Smeller, which helps you to find possible problems in the code. A tool to interactively report actual

or possible code syntax problems that are acceptable to the

development standards or may be considered inefficient.

A new buffer called *Magik Smeller* will appear showing a list of all possible code "smells",

Magik compiler but do not meet

their line

number in the Magik file and a short description. To jump back to a line of code that has been reported
as a smell, place your cursor on that line in the *Magik Smeller* and press "F3-j".

= <[> "Magik Smeller”

Fing}]l:k Smell Score:
ell per line:

45
0.381356

A Magik Smell is a piece of code that points to a possible coding problem.
To jump to the code in the original file that a line number is referring to, place your cursor

(5) TEXT ENCODING

a Magik file MUST have a text encoding declaration as its first line.

#% text enceding = iso8855 1

Line 1:

(5) PACKAGE DECLARATION

R

For example:

a Magik file MUST have a _package declaration at the top (usually the second line). For examp
_package sw

Line 1:

—1\**— *Magik Smeller* Top of 1.7k (1,0} (Magik Smeller HL Abbrev)-———Sun Feb 7 21:58-

'MangmaEr

Print in colour or black&white directly from the Emacs. Preview in colour — will create an HTML page with

current font locking highlights

in the code.

Save As...
Revert Buffer

Recover Crashed Session

8 Quick Print (to OS5 Default Printer)
Print Buffer

Print Region

Postscript Print Buffer

Postscript Print Region

Postscript Print Buffer (B+W)
Postscript Print Region (B+W)

CxCw
E, passing ARGS to

tmamn owns fow dasawimsion of ARGS.

&Print with Web Browser
PreBuview with Web Browser m

Print with &Notepad

the network follower.

Print &Region 3 &Print with Web Browser

hd

Print with &Motepad

Prefeview with Web Browser

Outline mode for Magik files. Using keys F3+Up/Down in the Outline mode the Magik file can be collapsed

to display only the method names and methods can be unfolded one by one for editing.

W Magm ECE Qutline Help

& 5 B4 =

B ox @ 0 &

= <] [» methods and classes.magik draw_arrow. mag|k example_plugin.magik example_|

#% text

- encoding = iso8859 1...

def slotted exemplar (:example framework,

example
example

_method
_method
_methad
_methad

framework. deflne_shared_constant(
framework.define shared constant (

:databus
:databus

example framework.linit actions () ...

anﬁ‘Toggle Outline Mode |

consumer data types, ...
producer data types, ...

example_framework.sw_databus_data_available{ data type name, data )

example framework.manage actions () ..

example_framework.belect_by_trail{}...

D 2017
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- Show/hide Line numbers in a buffer.

E/source/example_framework.magik] -= Sat Jan 30 22:58 =
SW  Magik ECB Help

LH%

s XEBFeE UL L ERHAEE x @ 4 b

T T T — o
4P glzthods_and_classe;;lagk draw_arrow.magik example_plugin.magik examplé Show Llne NUMbers |
87
88 # Expose this action only if we have rwos and a closed
89 _self.action(:select_in trail) .enabled? <<
20 _if .current trail _isnt unset _andif
91 current trail.closed?
92 _then
93 >> true
94 _else -
95 >»> false
96 _endif -
97
98 _endmethod
99 S
100

Q,

- Buffer selection- <Ctrl>+<left mouse button> will bring up the floating menu at the cursor position OR use
<Ctrl>+<Tab> to navigate between tabs in the Tab-bar.

= Sat Jan 30 23:02 =

2L Y EHEEx B LMY

s.magik draw_arrow.magik example_plugin.magik example_ﬁamework.magk

o0 see 1f there is already a trail created. If 5o, notify my
(as it has a diff] SelectBuffer E method
ibus data availabl future trail manipulations.

trail info << sa Mest recently used (11) 3

data (:map_trail)) _isnt unset
Changed files (1}

examp1e_gut . datan ETTECTNEN s sromnag i1_info)

Other files (1) r example_framework.magik
Other non-file buffers (5] » . .
. 5 - i . example_plugin.magik
gui.activate () Files by directory’

methods_and_classes.magik

- Save all file backups (*.magik~) in the single configurable directory (system %TEMP% — by default).

- Use icons to work with bookmarks OR use ‘breadcrumbs’ <F5-Spc> - to set series of breadcrumb

x 8 2 b
Edit/Get Bookmark

bookmarks with quick cycling through them using

<F5-Up/Down/Left/Right>.

|T|

Page 13
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Current Method name in the mode line can be toggled from the [Magik] menu

Heading f2h
Comment Region fo#
Uncomment Region f2 ESC #
Fill Comment f2q
Toggle... 23| v Method Name Display s}, usage={internall)
Customise v Electric Magik Mode » f2e
Help: Magik Language Reference Enable #Debug Statements <f3>d
Help <f1> ¥ Point at End of Marked Region isnt _unset _andif
Options: ize > 0 _andif
Transmit Method = Move to End nt _unset _andif
® Transmit Method = Do Not Move Poi sed?
Transmit Method = On Repeat, Move tEnd
tr
else
>> fals
endif
_endmethod

$
L

(Unix)--- highlight similar demo.magik [sw databus data available ()]

[Index] menu allowing quickly navigate between methods.

@ GNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oct 9
File Edit Options Buffers Tools SW Magik YASnippet Help

M. oy IRy s mlmoa ™ u,x,--zscrwa’au.-lqr:ﬂq

De
i j,“. highlight_similar_demo.magik

ey

- *Rescan*
Package 4
- [ , [ {sep1ication development exeamples),
## highlight_similar_plugin.init_actions()
## init_actions() s highlight_similar_plugin.manage_actions()
me 2 e S S % nam
= manage_actions() highlight_similar_plugin.select_by_trail()
select_by_trail() highlight_similar_plugin.sw_databus_data_available()
sw_databus_dati_i\flacbli(bdatfztip)f _‘name, d\af: )u; LI2 ]

Additional highlighting during the incremental search
@ GNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oct

File Edit Options Buffers Tools SW Index Magik YASnippet Help
DeExEs Y BBRAYYPIR I/ FEETEFEIQ LA
- highlight_similar_demo.magik
_endmethod

$

_pragma (classify_level@, topic={application development exeamples},
## Reacts upon information being available on the framework's
## databus.
_method highlight similar plugin.sw databus_data available ( data type na
_if data type name is :map Bl then
_if data _isnt _unset _then
.current trail << data[2]

Belise .

.current trail << _unset

46% of 3.5k (57,2

HYDE
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JE5 Speedbar 1.0.2 T =aia = |
[6:/DEV_LIG/Magik/SWAE/. .. B

/example_module/

[ resources

source

#%] example_ framework.magik
@] example framework.magikc
] example plugin.magik

B *2l1 Methods* A-Z
@ activate dialog()
a

1 sw_databus Uata availabl
*Class.Methods*
Exemplars

Properties

Public Methods
Shared Constants
new/init

@] example plugin.magike
@3 load list.txt

¢=] load list.txt

=] module.def

€1 description

I

- Speedbar (F11) - a special skinny frame with a specialized directory listing
in it. This listing will have both directories and filtered files in it. You can then load

files into your

methods/progs/constants/....

Emacs

buffer, or

multiple directories into your Speedbar frame.

expand the files to display all
in them and jump to those tags. You can also expand

the

Use 'Alt-x all <Enter>' or the icon to list\EDIT all lines matching a given regexp in *All* buffer. Changes
made in the *All* buffer is propagated to the original buffer. Use 'F3-j' from *All* buffer to go to a match

in the original file. Note that changes to the "*All*' buffer are propagated back to

the original buffer.

__\\Jt\i’_

il\ii,

=< A
Lines matching

_isnt unset _then

_endif
_elif data type_name _is :record selection _then
_if data _isnt unset _andif data[2]
.current rwo set new << data[2]
_else
.current rwo_set << rwo_sets
_endif

_endif

t

in the main b
# This is hnandy a5 we

exa.mple framework. maglk

"current_rwo™

when typing in "All" buffer-changes are reflected

liet the databus control
" 52% of 3.1k (65,0)

in buffer example fram

our actigHs.

(a5 rwo set)

{ Hocurrent rwolsi=ye unset], # Curgent rwos
focurrent rw set_newlf( data[2]
[apiteacliigate set << rwo_set.new()

*All*

211 of 205

(4,44)

(211 HL Abbrev)-————5Sun Feb

While you have a file loaded into the
Emacs buffer pressing <F12-F12> will

Magik Help

EYCEPERT
‘ot ( {Shon Almatchng  Jega )

-=Sun Feb 72252 =

‘GNU Emacs 23.1.1 [ e/DEV_LIG/Magik/SWAF/example_module/source/example_framework. magik]

File Edit Option:

Buffers

VASnippet  Tools

SW Cus

stom Magik Help

open Windows Explorer in the directory

of the current file.

DEEERB > ¥OBRBREXBEFE Y v A EaBHagg x°
= <] > example framewurk.mgg\l_c“”‘TEMP"*.magik
_if data type name _is :map trail _then
_if data isnt _umset then
.current_trail << datal[2]
. . =aea X
\.)\J [0« DEV.UIG » Magik » SWAF » cmple module » source &+ | 4p | [ szarcn P

Wy Organize

Favorite Links

More »

SWAF
. example_module I
resources

Folders o

. source =

example_framewark.magik

MNotepad++ Document

Date modified: 1/27/2004 3:17 PM
Size: 313 KB

en ~ (g Bum

=

Name Date modified Type Size
example_framework.magik 1/27/2004 3:17 PM MNotepad++ Docu...
example_framework.mag 9/8/2007 9:58 AM MAGIKC File
example_plugin.magik 1/30/2010 11:12 PM  Motepad++ Docu..
example_plugin.magike 9/8/20079:58 AM  MAGIKC File

load_list.bet

1/23/2004 7:03 PM

Motepad++ Docu...

Date created: 4/19/2009 12:28 PM

[0

ITI‘
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- Magik code folding — where large blocks of code can be distracting. With the code folding feature you can
hide the code not important to your current work. Code folding cleans your workspace. Use <Ctrl-.> key to
hide the block of code while your cursor is inside the desired block.

@ GNU Emacs 23.1.1 [ ei/DEV_LIC agik/SWAF/example_module/source/example_framework.magik] -= Sat Feb 20 22:50 -=

File Edit Options Buffers YASnippet Tools SW Magik Hide/Show Help

DeEERA s ¥ DBEREXE Her _JQXEE:-@@J%E]@X

= <[> example_framework magik

## Swm:h Hide/Show OFF
# Determine which data types we are interested in and what we

# should do with the data that is passed in.

_if data_type_name _is :map_trail _then m“"‘wmm
+ _if data _isnt unset _the;. (5) ...

_elif data type_name _is :record segection _then
_if data _isnt unset _apndif data[2] _isnt unset _then. (5)...

is is handy as we let e databus control our actions.

R Indicators of 'hidden’ code

- Use <Ctrl-,> key to hide/show code on the ‘method’ level

@ GNU Emacs 25.3.1 [ ¢;/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oct 9 12:36 0.42 =-

File Edit Options Buffers Tools SW Index Magik YASnippet Hide/Show Help

De@x@ s yaB Ryl reEFEHOQEA

- <+ highlight_similar_demo.magik

_pragma (classify level= m topic={application development exeamples}, usage={internal})
## Initialise the actions as provided by the highlight similar plugin

- method highlight similar plugin.init . actions (). (9). . ._endmethod
$

_pragma (classify level—m topic={application development exeamples}, usage={internal})
## Reacts upon information being available on the framework's.

- method highlight similar plugin.sw_databus_data ava:.lable( data_type_name, data ). (15)..._ endmethod
5

_pragma (classify_level=, topic={application development exeamples}, usage={internal})
## Enable or disable actions as appropriate.

- method highlight similar plugin.manage actions (). (10)... endmethod

$

_pragma(classify_level=, topic={application_development exeamples}, usage={internal})
- method highlight similar plugin.select by trail (). (12)..._endmethod
(o

IYI}
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- Magik Language Reference available within Emacs.

File Edit Options Buffers VASnippet Tools SW Custom SW Info Help

«ev @Rl EA

Up: (dir
(MagikLangRef) Top

Magik Language Reference

The sections in Magik language reference duplicate the information in Using
the Magik language, but the description here is more rigorous and assumes some
experience with using the language.

* see Syntactic elements summarises the simplest units of a program
such as literals, keywords, coperators and simple statements.

* see Expressions assignment and invocation describes simple
expressions and also the language constructions used for compound
expressions. Assignment and routine invocations are included here as they
are both discrete operations which can themselves be expressions.

* see Compound statements lists all the compound statements of
Smallworld Magik, including blocks, conditiocnals, loops, statements for
transferring control and statements for handling unexpected events.

* see Defining procedures and methods specifief the syntax for all
possible ways of defining a procedure or method, and includes handling

argument lists and results.

* see Variable declarations gives the five types of wariable
declaration with a description of the differences between them, and also
describes constant declarations, variable initialisation, use of packages
and the resolution of free wvariables.

* see Special characters and keywords lists all the special characters
[ | and keywords used in Magik, with references to where they are introduced.

*Menu:

* Syntactic elements

* Expressions assignment and invocation

* Compound statements

—-\%%- *info* (MagikLangRef) Top 3% of 1.8k (33,0) (Info HL YAS Rbbrev Narro

- Use %USER_EMACS% environment variable in gis_aliases to load your local Emacs settings, like
(setq programmer-tag "User Name, Company Name")
(setq project-name "Project Name")
(setq programmer-time-stamp-format "%:y-%02m-%02d"); %02H:%02M:%02S")
- [Alt-n] to insert-programmer-note;
[Alt-m] to insert-programmer-modified-note;

[Alt-c] to insert-change-note
around selected block — just select the
block of code and press <Alt-c> and

. _self. framework.databus.make data available (:geometry to highlight,
note change comments will be geom_sat)
placed around the selected code;
OR just use this to create a note
change.

START CHANGE
(2010-02-20 Igor Lapitski, Hyde Park)
Push it cut to the owning framework databus so that the Application Framework can

e Hk W Hh

respond to.

W

YT
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[Alt-h] to insert-method-comment;

- Save/Restore Emacs Sessions. That allows you to organize your different ya x 98
projects into "sessions". Each Session has a name (file name). When you 'Save '
Session’, the list of all opened files is saved into the current session and all the

files you were editing will be reloaded the next time you 'Restore Session'. This allows you to keep
different files open in different Emacs sessions. By using 'Save/Restore Session' you are activating 'Session
auto-saving mechanism' - on Emacs exit current Session will be saved automatically.

- To make prominent marks in '*gis*' buffer or comments in
'Magik' buffer use '@' at the beginning of the line in '*gis*'

buffer and '#@' in 'Magik' buffer. | found this useful When YoU e morter - oo st & wanto see
have a lots of output in the *gis* buffer and you need to see e e e
speC|f|c line — just use this in your code write(“@Important e, et ws dmid
info: “, a_variable) and you will be able to see this line in the

output very clearly.

ne which data types we ars interested in
i do with the data that is passed in.

.current_trail << unset

- Use F2-b to send <*.msg> file to running GIS buffer. This will load current *.msg file into an open
currently image.

- Emacs will display highlighting on :enabled?, _false,
. raction_message, :select_by_traill () 1))
whatever parenthesis matches the one endmethod _ )
—\**- example framework.magik 39% of 3.2k (47,72) mbbrev
before or after point. See message in [Ciacenes self.add action(... [-7-] &=

Mini-buffer describing the match when the matching parenthesis is off-screen. Message contains the line
number.

- Use 'Ctrl-TAB' to switch\cycling between Emacs buffers.

- When using <Ctrl-x/Ctrl-b> to bring up Buffer Selection Menu — use following keys : <c> - to change the

configuration; <s> - to save buffers marked with ’'*’ ; <d> - to delete buffer

Selected conflguratlon all

MR Buffer Size Mode File
highlight similar demo.magik 3549 Magik c:/SW43/app dev_examples/mo
% *GNU Emacs* (P 649 Fundamental
*scratch* (G k@y 156 Magik
*% *Messages* 3010 Messages
I *JDEE bsh* 0 Comint
: 1\%%- *buffer-selection* AL, rehE 570 (BR0) (Buffer-Selection-Menu HL yas Al

- List of key-bindings which might be useful in everyday Emacs operations with Smallworld environment:

<f2>TAB hippie-expand <f3>/ cb-and-clear

<f2> RET magik-transmit-thing <f3>? cb-help

<f2> ESC Prefix Command <f3>b cb-jump-back

<f2> # magik-comment-region <f3>c cb-paste-class

<f2> X dev-tools-object-inspector <f3>d toggle-transmit-magik-debug

I1I
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<f2> [ toggle-debug <f3>] cb-jump-to-source
<f2>b magik-transmit-buffer <f3>m cb-paste-method
<f2>e electric-magik-mode <f3> <f3> cb
<f2>g gis
<f2> k sw-reload-dotemacs <fa>c magik-copy-method
<f2>m magik-transmit-method <fa>d dev-tools-debug-method
<f2>q fill-magik-public-comment <fd>e magik-ediff-methods
<f2>r magik-transmit-region <f4>m magik-copy-method-to-buffer
<f2>s gis-version-selection <fad>n magik-set-work-buffer-name
<f2>t add-trace-statement above <f4>o dev-tools-object-inspector
<f3>t addtrace-statement below <fa>r magik-copy-region-to-buffer
<f2>x deep-print variable <f4> s magik-add-debug-statement
<f2>z gis <fad>w magik-compare-methods
<f2> <f1> sw-help-keys <f4> <f4> magik-symbol-complete
<f2> <f7> magik-transmit-method <fa>Db bury-buffer
<f2> <f8> magik-transmit-region <f4>g goto-line
<f5>g goto-line
<C-S>d duplicate current line <f6> magik-copy-method
<C-M> <up/down> move current line <f7> magik-transmit-method
<f8> magik-transmit-region
<f9> magik-mark-method
BOOKMARKS / BREADCRUMPS <f11> speedbar-get-focus
<C-f5> toggle visual boormark <f12> - ecb-cycle-ecb-buffers
<f5-Spc> set breadcrumb bookmark <f12> = ecb-maximize-window-methods
<f5> <delete> bc-goto-current <f12>b ecb-minor-mode
<f5><down> bc-local-next <f12>c ecb-toggle-compile-window
<f5> <left> bc-previous <f12>e send-file-to-external-editor
<f5> <return> bc-list <f12> h ecb-toggle-compile-window
<f5> <right>  bc-next <f12>q ecb-redraw-layout
<f5> <up> bc-local-previous <f12>r ecb-restore-window-sizes
<f5>a bm-toggle-cycle-all-buffers <f12>t ecb-toggle-layout
<f5>d bookmark-delete <f12>u ecb-rebuild-methods-buffer
<f5>e edit-bookmarks <f12>w ecb-toggle-ecb-windows
<f5> | bookmark-load
<f5>n bm-next <M-/> dabbrev-expand
<f5>p bm-previous <M-d> close window
<f5>s bookmark-set <M-b> move cursor to another buffer
<f5>w bookmark-write <M-f> move cursor to another frame
<M-m> insert-modified-note
<f12> <f12> w32shell-explorer-here <M-n> insert-programmer-note
<f12>m magik-copy-method-to-buffer <M-c> insert-change-note
<f12>n highlight-next-change <M-h> insert-method-comment
<f12>p highlight-previous-change <C-Tab> toggle between files
<f12>e send-file-to-external-editor

|
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Many of those settings are possible to
customise, use the menu SW->Customose-
>Customise Smallworld Emacs.

The background colour of the custom version

of the Emacs (wheat) also possible to
change. All custom settings will be saved in
the <.emacs-custom> file in your %HOME%
directory. See http://www.hydepark-
consulting.com/Emacs/  Emacs_colours.pdf
for all possible colours.

File Edit Options Buffers YASnippet Tools SW Custom Help

BE® s @84

= < B> *Customize Group: Smallworld* *Customize Group: Misc Custom*
Operate on all settings in this buffer that are not marked HIDDEN:
Set for current sessioﬂ Save for future sessions
Exit]

Undoc edits| Reset to saved Erase customizationd

Parent groups: Emacs
Parent group documentation: Manual.

/- Smallworld group: smallworld Development group
State|: visible group members are all at standard values.

Menu Sw Tools Submenu:
State: HIDDEN, invoke "Show" in the previous line to show.
List of Menu entries for SW->Tocls submenu.

Module Option Save Magikc: , Toggle| on (non-nil)

State|: STANDARD.

If t, save .magikc files when loading module.

Module Option Force Reload: Toqglel on (non-nil)

State|: STANDARD.

If t, save .magikc files when loading module.

Resources Group for Smallworld Emacs Message internationalisation.
Zliases Customise Magik aliases files group.
Magik Customise Magik Language group. b‘

Class Browser Running Magik Class Browser.

Gis : Running Smallworld GIS.

@jsc Custom

Customise Magik product.def files group.

LIG Custom Emacs User Setting
Product
13% of 1.8k (40.0)

—1\**— *Customize Group: Smallworld*

Mon Feb 15 00:09
File Edit Options Buffers YASnippet Tools SW Custom Help

RE®s @8 d

= <] [ "Customize Group: Smallworld® *Customize Group: Misc Custom™

ECB load on Emacs sStart up?

Pair Mode: , Value Menﬂ OFF
State|: STANDARD.

Pairing mode on Emacs start up?

Toggle Pabbrev Mode: , Value Menﬂ ON
State|: STANDARD.

Predictive Abbreviation on Emacs start up?

Toggle Ac Auto Start: , Value Menﬂ Require: 3

State|: SAVED and set.

Non-nil means completion will be started automatically. .

Initial Frame Width:

State|: STANDARD.

WIDTH of the Initial Frame

; 135

Initial Frame Height: , 43

State|: STANDARD.

HEIGHT of the Initial Frame

Custom Background Color:

State|: STANDARD.

Emacs background color

; wheat

custom Modeline Background Color:

State|: STANDARD.

Emacs modeline background color

Custom Foreground Color:

State|: STANDARD.

Emacs foreground color

s black

Custom Backup Directory:

State|: STANDARD.

—-1\**- *Customize Group: Misc Custom*

¢ C:\TEMP

; wheat3

37% of 1.7k (44,45) (c
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- There are several predefined custom colour Themes for Emacs

eGNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oci

File Edit Options Buffers Tools SW Index Magik YASnippet Hide/Show Help

v Highlight Active Region FE#R L
+ Highlight Matching Parentheses
e = endif
Line Wrapping in This Buffer > -
Default Search Options >
~ Use CUA Keys (Cut/Paste with C-x/C-c/C-v)
~ Use Directory Names in Buffer Names topic={application development exeamples},
v/ Save Place in Files between Sessions Jin.select by trail ()
~ Blink Cursor losed by the current trail belonging
~ Enter Debugger on Error be as those seelcted.
Enter Debugger on Quit/C-g rew () .
. . set.all collections () .fast elements ()
Multilingual Environment > E — —
Show/Hide > i .name)
Set Default Font...
Save Options application.database.rwo_set () .select (:col
Manage Emacs Packages tred rwo set.geometrv set (.current trail.wc
Customize Emacs > Cystom Themes
<elf.databus make data / Tkhoose a pre-defined customization theme |
- - B Browse Customization Groups =@t )
1(Unix)--—- highlight simjla: Saved Options trail ()] 78% of 3

-+ *Custom Themes*

Type RET or click to e = -
Type ? to describe theftheme . SpecificOption..

New Options...
le/d 2 mes .

Theme files are namegl *-theme  Specific Face.. d-path’ .
Specific Group...
Note: Your custopf settings ti  AllSettings Matching... phe settings.
To migra your settin(  Options Matching... pere.

Save Theme

Faces Matching...

= Select more th

one theme at a time

Available Custom Themes:

z adwaita -—- Face colors similar to the default theme of Gnome 3 (Adwait:

o deeper-blue -- Face colors using a deep blue background.

s dichromacy —-- Face colors suitable for red/green color-blind users.

s leuven —- Face colors with a light background.

s light-blue —-- Face colors utilizing a light blue background.

s manoj-dark —- Very high contrast faces with a black background.

s misterioso —-- Predominantly blue/cyan faces on a dark cyan background.

g tango-dark —- Face colors using the Tango palette (dark background) .

m tanan —— Fare cnlare neina tha Tanan malette (1Tiaht hackarannd)

1\%*— *Custom Themes* Top of 1.3k (1,0) [ (Themes HL yas Abbrev)
HYDE
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Use them based on your own taste:

@ GNU Emacs 25.3.1 [ ¢:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oct 9 13:14 0.38 =-

File Edit Options Buffers Tools SW Index Maglk YASnlppet Hide/Show Help

OBEx 8 *LBEIRYPAG T
-+ highlight_similar_demo.magik

:record selection
andif data |2 isnt unset

~

data |2

_is

data type name
data _isnt

assify_level=m,

method highlight similar plugin.
_Selit. :filter to trail

enabled? <<

topic={application development exeamples

usage= internal

_isnt unset andif

> £
isnt unset andif
.closed?

@ GNU Emacs 25.3.1 [ c:/SW43/app_dev_examples/modules/highlight_similar/source/highlight_similar_demo.magik] -= Mon Oct 9 13:19 0.64 =-

File Edit Options Buffers Tools SW Index Magik YASnippet Hide/Show Help

OEE*E % y0DIR o s Pa6e - EFEHASE 54
=< highlight_similar_demo.magik

_else
current rwo_set << rwo_set.new ()

endif
_endif
self.manage actions ()
endmethod
8

## Enable or disable actions as appropriate.

enabled? <<

method highlight similar plugin.manage actions ()
_if .current rwo_set

_self.action(Tfilter_to_trail).

_pragma (classify level:m topic={application_

development exeamples}, usage={internal})

isnt _unset _andif
andif

.currenq_rwq_set.gize > 0
_andif

.current trail isnt _unset
.current trail.closed?

_then
>> true
_else -
>> false
_endif -

éFndmethod
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Key bindings for Magik mode

Several of these commands interact with a Smallworld session. If there is a current Gis buffer, or only one Gis
buffer, then the corresponding Smallworld session is used; otherwise, you are prompted for the required Gis
buffer.

Commands which provide an interface to the Development Tools application are only applicable when this
application is available in the relevant Smallworld session. The application is loaded and started if necessary; any
errors are reported to the relevant Gis buffer.

F2,B Transmit the buffer to a Smallworld session.

F2,Ror Transmit the current region to a Smallworld session.

F2, F8 or F8

F2, M or Transmit the method which contains the cursor position to a

F2, F7 or F7 Smallworld session.

F2, Enter Transmit the top-level Magik language construction surrounding the point in the current buffer, such as a
method or procedure definition, to a Smallworld session.

F2,$ Transmit the chunk of Magik code, delimited by S lines, and containing the cursor position, to a Smallworld
session.

F4, F4 For a running Smallworld session, finds the symbol that starts with the current word, or lists all the available
completions.

F4, O or Inspect a Magik object. Prompts for an expression which is

F2, Shift+X evaluated within a Smallworld session to return the object to

F2, X inspect; the word at the cursor position is available as a default.

F4, O and F2, Shift+X  display the object in an Object Inspector from the Development Tools application.

F2, X displays the object in an Emacs Deep Print buffer.

F4,D Send a method to a Magik Debugger from the Development Tools application in a Smallworld session.

F2, Spacebar Insert the Magik template for the preceding text

F2, # Add a leading # to each line in the region to convert them to comments.

F2, Esc, # Remove a leading # from each line in the region.

F2,Q Fill comment line. Formats the current line into separate comment lines, adding leading indentation and # or
## to match the initial line.

F2,H Format the current line as a comment heading.

F2, T Add a trace statement above current line. When executed, the text of the current line is output.

F3,T Add a trace statement below current line. When executed, the text of the current line is output.

F4, S Add a Debug statement; a toggle is available so that Debug statements can be transmitted as comments or
as executable commands.

F4, R Copy the current region to a work buffer.

F4, M Copy the current method to a work buffer.

F4, N Open a work buffer and give it a name.

Ctrl+M+H or F9 Mark the current method.
F4, Cor F6 Copy the current method.

F4, W Compare methods using standard Emacs facilities.
F4, E interfaces to the Emacs command compare-windows.
HY' [
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Key bindings for other modes

Some key bindings are available for the other Smallworld major modes.

Aliases mode
Ctrl+C Run command definition. In the Aliases buffer, finds the command definition which contains the cursor
position and uses the launcher program to run it; otherwise prompts for the required definition.

Environment mode
A buffer in Environment mode is readonly so alphanumeric keys are used as shortcuts for commands.
Enter Select the Smallworld Core product indicated by the cursor middle-clickposition; this product installation
defines the environment for any new Smallworld sessions.
Spacebar Move the cursor to the next product installation in the buffer.

R Run the Gis command in the environment defined by the cursor position. Does not change the environment
for any other sessions.

+ Add a new product installation; prompts for the Smallworld Core product location, and a name and version
for the installation. Only available if a version file is in use.

Q Quit; closes the buffer without making any change to the environment.

Loadlist mode

F2,B Transmit buffer. Uses the load list to load Magik files into a current Smallworld session; prompts for the
required Gis process if there is more than one.
F2,C Toggle to control whether compiled Magikc files are saved.

Ctrl+C, R Refresh buffer. Uses the current contents of the directory containing the load list file to update the contents
of the buffer. You can change the order of entries and save a new load list file if required.

Message mode
F2,B Transmit buffer. Compiles the buffer contents and loads into a current Smallworld session; prompts for the
required Gis process if there is more than one.
F2,C Compile message file. Compiles the buffer contents ready for loading, but does not load it.
F2, Up Arrow Move the cursor to the previous or next message.
F2, Down Arrow
F2, M Mark message.

Module mode

F2,B Transmit buffer. Uses the buffer contents to load all module source files and all compiled message files into
a current Smallworld session; prompts for the required Gis process if there is more than one.

F2,D Reload module definition. Loads the buffer contents into a current Smallworld session; does not load
module source files or resources.

F2,C Compile message files. Compiles all message files for the module ready for loading.

F2, Shift+R  Remove module definition from a current Smallworld session. This is sometimes required to ensure the
correct functionality is included in the session.

F2,S Toggle the option to save compiled Magikc files when loading module source files.

F2,R Toggle the option to force reloading of a module which is already loaded.

Product mode

YT
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F2,B Transmit buffer. Uses the buffer contents to add the product to a current Smallworld session; prompts for
the required Gis process if there is more than one.

F2,R Reinitialise product. Uses the buffer contents to redefine the product in a current Smallworld session where
the product is already defined.

YT
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